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1. Welcome to COPA-DATA help

GENERAL HELP

If you cannot find any information you require in this help chapter or can think of anything that you
would like added, please send an email to documentation@copadata.com
(mailto:documentation@copadata.com).

PROJECT SUPPORT

You can receive support for any real project you may have from our Support Team, who you can contact
via email at support@copadata.com (mailto:support@copadata.com).

LICENSES AND MODULES

If you find that you need other modules or licenses, our staff will be happy to help you. Email
sales@copadata.com (mailto:sales@copadata.com).

2. Licensing

To be able to use zenon as an editor or Runtime, the product must be licensed. zenon runs in Demo
Mode (on page 6) until it has been licensed.

3. License zenon

To license zenon:


mailto:documentation@copadata.com
mailto:support@copadata.com
mailto:sales@copadata.com

Open Start -> All Programs -> COPA-DATA-> Licensing
Or:

In the zenon Editor, open File -> General configuration -> License product ...
Or:

In the Startup Tool, click on the Tools button, select Licensing then click on Start.
The dialog for entering license data opens.
Select zenon Editor/Runtime
Enter serial number and activation number
You find the data for this:
e onyour license certificate
e  Onthe license sticker
e inthe license file License.txt
Path Windows 7/8: C: \Users\Public\Documents\zenon Projects\
Note: Pay attention to capital letters and small letters when entering the data!

After the Editor/Runtime is restarted, use zenon with the license entered

LICENSING DIALOG

Product licensing

Dongle licensing
Fleaze enter the license information of wour license form / license badge, which pou received after
ordering a dongle license. Care for conect capitalization. The entered numbers are saved with OF.

Soft licensing

After ordering a zoft license you will receive a license form with a zerial number. Please enter this
zerial number and then execute 'Get soft license’. Thus a hardware specific licenze number iz
generated and saved in a test file. Send thiz file to your distributor. Then vou will receive a valid
activation number. Enter the activation number in this dialog and confirm with OF.

Altention!

Thiz program iz not suitable for licensing of older versions. Please use the licenzing software
appropriate for your version,

(®) Editor / Rluntime () wieh Server

Serial number

Activation number

(] 3 Cancel Get zoft license



Parameters Description

Editor/Runtime Active: License is valid for the zenon Editor or the zenon Runtime.
Web Server Active: License valid for zenon Web Server.
Serial number License serial number.

If there is already a license available, its serial number is displayed
here. Enter the current serial number here.

Activation number License activation number.

If there is already a license available, its activation number is
displayed here.

oK Import data and start zenon with this license when it is next started.
Cancel Discard entries and use zenon with the previous license or no license.
Request soft license Opens the dialog to request a soft license.

4. Demo mode

If the editor is not licensed, it runs in demo mode. Runtime runs in demo mode if it is not licensed.
Demo mode Conditions
Editor: The Editor runs:
» thefirst 40 times it is started for 30 minutes
» from the 41st to the 50th Start: 20 minutes
» from the 51st Start at: 10 minutes
Runtime: A not-licensed Runtime runs for 30 days or 40 starts according to which comes first.

From the 41st start or the 31st day on, Runtime only runs for 10 minutes.
The user is informed that it is running in demo mode when it starts.

Note: This behavior for unlicensed version is also applicable to the zenon Logic Workbench and
Runtime.



Version information

Zzenon

5. Version information

You can see which license you are currently using and which modules are included in this when starting
zenon in the start screen or after clicking on Info on... in theHelp menu:

ﬁ" ) <ion 7.11 SPO Build9239 32Bit
1M1
Activation ﬁ?&sf

rved. © Ing. Punzenberger COPA-DATA GmbH 1993-2013

Editor + RT — Number of tags: unlimited A N /
Historian S
Extended Trend =it
Report Generator Report Viewer b o
Recipegroup Manager B D
< Contral ¥ 0 =~k ‘,‘5 S
N s o
X bk ﬂ'\
Editor version Editor version number.
Serial Number License serial number.
Activation number License activation number.
Expiration time (optional) Information on the expiration date of the license for limited
licenses.
Field with modules: Information on licensed module.

In menu Help the entry Info about opens a dialog box which offers information about the zenon
version and the licensing.

6. Selecting the appropriate license size
The licenses for the Editor and the Runtime are calculated by adding up the necessary TAGs or 10s.

CALCULATION VIA TAGS

1 TAG equals 1 variable. For determining the license size, consider the total number of TAGs (=
variables) of the following drivers:




» PLC drivers and bus drivers

Variables of the following drivers do not count:
» Internal driver
» system driver
» mathematics driver

» simulation driver

You can license TAGs for the Editor and the Runtime in the following gradation:

» 64 TAGs

» 128 TAGs

» 256 TAGs

» 512 TAGs

» 1,024 TAGs
» 2,048 TAGs
> 4,096 TAGs
» 8,192 TAGs

» 16,384 TAGs
» 65536 TAGs

» unlimited

A license upgrade to a higher number of TAGs is possible at any time.

CALCULATION VIA I10S
License can also be based on 1/Os. For determining the license size, consider the total number of 10s of
the following drivers:

» PLCdrivers and bus drivers

Variables of the following drivers do not count:
» Internal driver
» system driver
» mathematics driver

» simulation driver



CALCULATION

Data type Valence
1 bit 11/0s
1 byte 81/0s
1 WORD 16 1/0s
1 DWORD 16 1/0s
1 float 161/0s

1 string (max. 64 characters) 16 1/0s

If you cannot find the desired data type in the list, it is because of the selected driver. Some drivers have
a specific denotation of the data types. You will find more information in the driver documentation of
the driver you use. You will find this either in the online help in the Drivers section, as a PDF file on our
installation medium or on our website www.copadata.com (http://www.copadata.com) in the
download section.

£ Example

96 binary and 20 numerical values are to be visualized in zenon:

Multiply the 20 numeric values with 16 and you receive 320 I/Os. Add these to the 96
binary values. As a result you get 416 I/Os, which now are the basis for the license size.

DISPLAY IN ZENON

In the status line of the detail view of the variables the following information can be found:

=1 Driver : BUR20032 - B&R-Syster
0110-001-0020BMaAx
0110-001-0020BMAx
0110-001-00201SPOO
0110-001-00201SPOO
0110-001-00201SPOO
0110-001-00201SPOO
0110-001-00201SPOO
0110-001-00201SPOO
0110-001-00201SPOO
— 0110-001-00201SPOO
0110-001-00201SPOO
0110-001-00201SPOO
0110-001-00201SPOO
0110-001-00201SPOO
0110-001-00201SPOO

4

==l
= 11.3799/550/1 || 22730/unbegrenzt

£

» How many I/Os are used currently.

» How many I/Os are licensed.

An example:
» 3799/550/1: 3799 entries exist, 550 are listed because of a filter, one entry is selected.

» For project 22730 an unlimited number of I/Os is licensed.


http://www.copadata.com/

NOTE FOR CLIENT LICENSE

You can use client licenses if:
» The start project is a standalone project or a client
» The start project uses a maximum of 64 TAGs when a license is required, if it is not a client

» All subprojects are clients

7. Types of licensing

You can license zenon in different ways:

» Soft licensing (on page 11): Requests a unique PC identification number when the editor or
Runtime is started.
Characteristics:

e The license cannot be stolen.
e Thelicense is computer related.
e  Practical for notebooks.

» Dongle licensing (on page 12): Looks for a hardware dongle at a parallel port or USB port when
the editor or Runtime is started.

Dongles are available as:
e  Workplace dongle:

e Network dongle: A certain number of licenses are booked on a central dongle on the
network, which can be used at the same time as concurrent-use licenses.

Notes for dongles:
e easy handling
e Alicense can be taken from one PC to another by simply moving the dongle.

e No problems due to hard disk failures

10



7.1

The soft license assigns a computer with a unique identification. In doing so, certain components of the

¥ Information

If there is no license or all licenses are are assigned in the network, then the editor or

Runtime starts in demo mode (on page 6).

Soft licensing

computer are examined. This license always only works on a certain computer. If it is to be transferred

to another computer or too many components on the licensed computer are changed, it must be

reissued.

To obtain a software license:

1.

v ok w N

Lo ©® N O

In the File menu, select: General configuration -> License product.
The licensing dialog (on page 4) opens.

Enter the serial number.

Click on Request soft license.

The product licensing dialog opens.
If this has not yet happened, enter the serial number.

Click on License request for soft licensing.

Enter your contact details.

click on Next.

There are two possibilities for sending these:

a) automatic

e Click on the Send to button

e Select the desired COPA-DATA organization

e  When clicking on OK, the license request is sent by your email program
e via button Print you can print your copy or send it to a connected fax machine
a) manually

e  Click on the Finish button

e The license request is saved as a text file

e Aninformation window informs you of the name and save location

11



o thefile is automatically opened in the Text Editor

e send the email by email or fax to your sales partner

As soon as you have received your license data, reopen the licensing dialog and enter your activation
number.

7.2 Dongle licensing

With dongle licensing, a dongle is connected directly to the computer for an individual workspace
license or to a network computer for a network license. zenon uses two dongle systems:

» CodeMeter (on page 13)
(included with setup)

» WibuKey (on page 34)

(software included on installation medium)

Software necessary for the installation of CodeMeter licensing is also automatically installed during the
installation of zenon.

WIBUKEY

The additional WibuKey administration software is no longer automatically installed with the setup from
zenon version 7.50.

This software is however supplied with zenon. If necessary, install the current version of the WibuKey
software from your zenon installation medium:

» \AdditionalSoftware\WIBU-SYSTEMS WibuKey

Note: Users who already work with WibuKey continue to receive new licenses for their WibuKey
dongles.

CONFIGURATION

In general, no further settings need to be made for dongles used locally. The use of network dongles
may mean that individual configuration is necessary. You can find these in the respective dongle
software.

For details of this, see the chapters on the WibuKey (on page 34) and CodeMeter (on page 13).

12



7.2.1 CodeMeter

CodeMeter can be used at a single workplace or in a network. The CodeMeter USB stick must be active
in a USB port on the local computer or as a server on a network computer. The dongle firmware must be
at least version 1.16 or above.

& Attention

If the dongle is removed during operation, the editor closes. The editor then opens in
demo mode until a valid license is recognized.

To configure, start the CodeMeter control center administration application via: Windows Desktop ->
Start -> All programs -> CodeMeter -> CodeMeter Control Center.

The CodeMeter control centre opens with 3 tabs:
Licensecontains information on the dongles found.

Events: Displays the number of sticks connected, the license entries, the firm items found and all access
to the CodeMeter Runtime server. To log the entries on a permanent basis, activate the logging entry in
the file menu.

Allocation: Configures the allocation of licenses.

LICENSE

File Process View Help

License Events Borrow
cML -
Mame: CM1 é’
€' 21355435 &)
Serial: 2-1355435 @
Version: CmStick 1.16
Capadity: 93 % free (366704 Bytes)
Status: () @ Disabled
@) (g Enabled until unplugged
@ @ Enabled
License Update Eject Change Password
CodeMeter is started. WebAdmin

13



Parameters
License

Name

Serial no._
Version
Status

Deactivated
Activates when connected

Activated

License updating
Eject
Change password

CodeMeter has been started/stopped

WebAdmin

Update certified time

Description
Lists all active CodeMeter sticks

Individual name of the stick selected; can be assigned
with the button on the right.

Serial number of the stick selected.
Firmware version of the selected stick.
Status of the selected CodeMeter stick.

The stick connected is deactivated and cannot be used by
any application.

The Stick is activated so long as it is connected; it is
automatically deactivated after it is removed from the PC.

The stick is fully activated and remains activated after it is
removed.

Recommended status: Ensures that unauthorized persons
do not have access to licenses and personal data (such as
CmPasswordManager) if the stick is lost.

Starts the assistant to add, amend and delete licenses.
Allows the stick to be ejected.
Enables the password to be changed.

Information on whether the CodeMeter service is
running. Can be changed in the Action menu.

Starts the web browser with the administration user
interface for network dongles Port 22350 must be open
for this, for details, see the chapter on network
administration (on page 15).

You can update the certified time saved in the dongle via the CodeMeter time server. To do this, you

need an active Internet connection.

To update the time:
1. Start the CodeMeter WebAdmin

2. Check your network settings (on page 21):

a) Are the proxy settings correct in CodeMeter Webadmin?

14



b) Is your access data up-to-date?

Click on OK.

N o v & W

Go to the Contents -> CmStick menu

Click on the Update button.

28), you primarily check your access data.

You are notified that all sticks have been updated with this.

You receive information on the update carried out. In the event of an error message (on page

IRLLILC content

Network administration

CmStick Licenses User

CodeMeter WebAdmin

- fauralio
Data Backup/Restore

Cmstick: 2-1355435 [=]
Name: M1

Hardware: CmStick 1.16.000

First Device: T: (Mo Flash)

Status:

ed until Unplugged

Certified Time: 2009-10-01 13:42:08 Update

Box Time: 2009-10-
System Time: 2

Free Memory: o

£.704 Bytes) | Defragment

;\/J

For network administration, start the WebAdmin user interface by clicking on the WebAdmin button in

the CodeMeter control center. Detailed information on the individual settings can be found in the
CodeMeter WebAdmin help pages. You get to this via the Help button in WebAdmin. The most
important options and instructions are also in this document:

» CodeMeter stick administration (on page 16)

» License administration (on page 17)

» Saving license data (on page 17)

» Network settings (on page 21)

» Proxy settings (on page 21)

15



A Attention

CodeMeter WebAdmin uses port 22350. Note:

» If a firewall other than that integrated into the Windows operating system is
used, this port must be enabled.

» If the port is changed, the WebAdmin surface cannot be started, because the
port is part of the address, for example:
http://localhost:22350/Content.html?BoxSerial=2-1355435

In this case, use appropriate freeware tools or standard Windows tools to
determine which port is currently being used and enter this address into the
address line of the browsers instead of 22350. Then change the port back to
22350 in WebAdmin.

CodeMeter sticks

WebAdmin starts in Contents/CmStick view.

Here, you select the desired dongle in a drop-down list and can see its data and status as configured in

the control center (on page 13).

CodeMeter WebAdmin C\/J
S content TS S

onfiguratios
CmStick Licenses User Data Backup/Restore

CmStick: 2-1355435 =]
Name: €M1
Hardware:

First Device:

Status:

ed until Unplugged

Certified Time: 2009-10-01 13:42:08 Update

Box Time:

System Time: 2

Free Memory: o

£.704 Bytes) | Defragment

16



Parameters
CmStick
Name
Hardware

First drive

Status

Certified time (on page 14)

Box time
System time

Free memory

Licenses

Description

Drop-down list of recognized sticks.

Shows the name given in the control center (on page 13).
Hardware version of the stick.

Drive information for the stick, drive sizes are only given
for sticks with flash memory.

Activation status as defined in the control center (on page
13).

The certified time saved on the stick. is updated using the
update button.

Note: to update using the CodeMeter Timeserver, you
require an active internet connection. Ensure that the
network settings (on page 21) are correct, in particularin
relation to current access data.

Internal time saved on the stick.
Local time on the CodeMeter Runtime server.

Free memory available on the stick. To defragment the
memory, click on the Defragment button.

You administer your licenses in the Licenses tab in the Contents menu.

» Select the desired dongle from the drop-down list.

17



Types of licensing
zenon

» You can find information on the licenses of these dongles below the Ing. Punzenberger
COPA-DATA GmbH subheading.




Types of licensing
zenon

Product Code Numerical value for the product. Clicking on the number
leads to the details.

Name Ing. Punzenberger COPA-DATA GmbH

Usage units If applicable, display of usage units remaining.

Expiration date If applicable, the expiration date is shown. zenon
switches to demo mode (on page 6) after this point in
time.

Activation date If applicable, the activation date is shown. zenon switches

to demo mode (on page 6) before than.

Number of licenses Total number of licenses

» Click on the number in the Product Code column for details.

m' [g http:/lacalhest:22350/Productitem htmi?BexSerial=2-1355427 &FirmCoc -[‘9] x][-ﬂ Google » ']

¢ Favorites | (@ CodeMeter | WebAdmin ]_|

Home Server Configuration Diagnosis  Info

Product Item Details
Product Item 101202:1 of CmStick 2-1355427

Text 28 Dongle Number
Expiration Time 4 data, serial, counter | 2015-12-31 01:00:00
License Information 8 50000111

Dongle number Must correspond with the number of the active dongle.

TIME LIMITS

A dongle can also have a time limit:

» Expiration date




» Time period for use

EXPIRATION DATE

The dongle is equipped with an expiration date.

In the Licenses tab in the Contents menu, the expiration date is given in the expiration date column
with the date and time in UTC format.

CodeMeter WebAdmin C\d
LLET content [T r— Aaonoch ry =

CmStick Licenses User Data Backup/Restors

CmsStick: 2-1355427 L=]

100002 | Bundling Articles

Unit Counter

nfa

Time License Quantity

TIME PERIOD FOR USE
The dongle is equipped with a specified usage period. This starts from the first time that zenon Editor or
Runtime is used. To check the time limit:

» Navigate to the Licenses tab in the Contents menu

» Click in the entry under Ing. Punzenberger COPA-DATA GmbH on the digit in the Product Code
column

» The Product Item Details window opens

20



>

&) hitp://localhost: 22350/ Productitem. htmi 76

213554298 FimCode= v | 43 | X [ |2 Google

Types of licensing

You can see the licensed period and the start date in UTC format in the Usage period line.

¢ Favorites | (@ CodeMeter | WebAdmin

Home Server

Configuration Diagnosis  Info

Product Item Details

Product Item 101202:1 of CmStick 2-1355429

Text 28 Dongle Number
. 2 days - Start Time: 2009-10-22
Usage Period 20 11:56:03
) ) data, senal,
4
License Quantity T 2
License Information 8 50000111

Network and Proxy

For faultless communication with a Network dongle and the start of WebAdmin, correct network

settings are a requirement.

Home Content Server

Bind Address *:

Network Port =:

Diagnosis  Info

Network

All {Default =
22350

UDP Waiting Time *: 1000 ms

Run Network Server: [

Server Search List:

(299 | remove | |  down |

(™) Changes only take effect after restarting CodeMeter

Zzenon




Parameters

Network address

Network port

UDP response time

Start as server

Server search list

PROXY SETTINGS

Description

Select an IP address to which the CodeMeter Runtime
server should connect.

Standard: A11.
The connection is made to the first CodeMeter Runtime
server found.

The choice of a defined address is primarily necessary if
the computer is functioning as a network license server
and has several
network cards.

Port for CodeMeter communication in the network.
Standard: 22350

The value can be adjusted individually. In this case, it
must be ensured that all CodeMeter Runtime servers use
the same port.

Recommendation: do not change port.

Maximum response time within which a UDP request
must be answered.

Standard: 1000 milliseconds.

Active: The computer becomes a CodeMeter network
server and makes all its licenses available in the network.

Here, specific CodeMeter network servers can be defined
by entering computer names or IP addresses. Then only
the servers defined in the list are searched for. This way,
requests from clients are directed to a defined
CodeMeter Network server.

Note: If a CodeMeter Server is in a different
subnetwork, use the IP address for the search list.

This search list should only be used if the CM stick
cannot be found in the network.

For access to CodeMeter services in the internet, such as time server, enter the applicable access data

for your company here.

22



CodeMeter WebAdmin C“
| Home Content Server [JIUMHEIIH  Diagnos! -

Metwork Proxy Access Control Certified Time WebAdmin Backup Borrowing

Proxy Settings

Proxy Support: ¥ enabled

Proxy Server: CDSBG001.sbyg copadsta
- Proxy Port: BOB0
Authentication ¥ enabled

- Prouy User: GematB

- Proxy Password: ssesses

Apply

A Attention

CodeMeter notes this access data. If you regularly change your access password, you
must also change this in the CodeMeter WebAdmin proxy settings!

Request license

To request or update licenses for CodeMeter, select the Update license button in the Licenses tab in

the CodeMeter control center (on page 13). The license update assistant starts:

(&) CmFAS Assistant -7 |z
Welcome to the CmFAS Assistant!

The CodeMeter Field Activation Service (CmFAS) assistant helps you adding,
changing and deleting licenses from the license management system CodeMeter,

With the CmFAS assistant you can create license request files, which you can send
to the producer of the software by email. You can also import the received license
update files with the CmFAS assistant into the license management and create a
receipt of the import for the producer.

< Back Mext = ] ’ Help

Decide if you are:

23



» requesting a license
» entering a license update

» wish to create a receipt for COPA-DATA

(&) CmFAS Assistant -7 |z
Please select the desired action

@ Create license request

Choose this option if you want to create a license request file in order to send it
to the producer of the software.

() Import license update

Choose this option, if you received a license update file from the software
producer and want to import this file.

) Create receipt

Choose this option if you want to confirm the successful import of a license
update file for the software producer.

< Back ] [ Mext = ] ’ Help

LICENSE REQUEST

With license requests, you can:
» extend an existing COPA-DATA license

» create a new COPA-DATA license

(&) CmFAS Assistant -7 |z
Please choose an option for the license request
@ Extend existing license

Choose this option if you want to change an existing license or to add new
licenses to an existing license of the same producer,

) Add license of a new producer

Choose this option if you want to add a new license and there are no licenses
from this producer in the selected license container.

’ < Back H Mext = ” Help

» To add another COPA-DATA license:
o Select Ing. Punzenberger COPA-DATA GmbH
» To create a new COPA-DATA license:

e enter the CodeMeter FirmCode that you received from COPA-DATA.



» Select a save location for your license request.

Adapt license

You can adapt the scope of your license concerning extent and runtime at any time. To do this:
1. order the desired change at COPA-DATA
2. You will receive a *.WwibuCmRaU file for your dongle.
3. installit:
a) either via double click on the file
b) or by dragging the file ion the CodeMeter control center
4. You will receive a message about successfully updating your license.

If you receive error message (on page 28) 229, the license on the dongle is already up to date

If it is necessary for your license request to create a .WibuCmRac file or to install the . WwibuCmRaU file
with the update manually, follow the instructions in chapter Update license manually (on page 25).

Request or update license

To update your license manually:
1. createa .WibuCmRaC file
2. send the file to COPA-DATA
3. you will get an updated .wibuCmRaU file
4

copy this to the dongle

CREATE WIBUCMRAC FILE

1. Make sure that the CodeMeter dongle is connected to your PC.

2. open the CodeMeter control center, e.g. via Start -> Programs -> CodeMeter ->
CodeMeter Control Center

3. ontab License click button Update License

4. The license update assistant starts

25



5.

7.

click on Next

(&) CmFAS Assistant -7 |z
Welcome to the CmFAS Assistant!

The CodeMeter Field Activation Service (CmFAS) assistant helps you adding,
changing and deleting licenses from the license management system CodeMeter,

With the CmFAS assistant you can create license request files, which you can send
to the producer of the software by email. You can also import the received license
update files with the CmFAS assistant into the license management and create a
receipt of the import for the producer.

< Back [ MNext = ] ’ Help

select Create license and click Next.

(&) CmFAS Assistant -7 |z
Please select the desired action

@ Create license request

Choose this option if you want to create a license request file in order to send it
to the producer of the software.

"~ Import license update

Choose this option, if you received a license update file from the software
producer and want to import this file.

) Create receipt

Choose this option if you want to confirm the successful import of a license
update file for the software producer.

’ < Back H Mext = ” Help

select Enhance existing license
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8.

10.
11.
12.
13.

click on Next

(&) CmFAS Assistant -7 |z
Please choose an option for the license request

@ Extend existing license

Choose this option if you want to change an existing license or to add new
licenses to an existing license of the same producer,

| Add license of a new producer

Choose this option if you want to add a new license and there are no licenses
from this producer in the selected license container.

I < Back H Mext = H Help

in the following dialog click Next again

select the desired location for the appropriated .WwibuCmRac file
click on Apply

the .wWibuCmRac file is created

send the file to sales@copadata.com

INSTALL WIBUCMRAU FILE

You will receive an updated *.wibuCmRaU file from COPA-DATA.

Install the file via double click on the file on the dongle.

Alternative:
1. open the CodeMeter control center
2. selectinstall license update
3. follow the instructions of the installation wizard

27



Troubleshooting

Error Solution
zenon only runs in demo mode. Check
» your licenses
» The connection to the network dongle

» if the license information (SERIAL7= and ACTIVATIONKEY7=)
was correctly entered in zenon6.ini. Note any possible blank
spaces behind the serial number (SERIAL7=) or the activation
key (ACTIVATIONKEY7=).

Path for zenoné6.ini:
Windows /7/8: %ProgramData%\COPA-DATA\System

Dongle is not found. » Check the network settings (on page 21).

» If the stick is in another domain, add it to the server list (on
page 21).

» Increase the UDP response time (on page 21).

» Ifitis a virtual machine, then configure the stick as
removable media (on page 29).
Attention: Configuration as removable media can -
depending on the computer configuration - also lead to a
computer no longer booting.

»  Configure the stick as HID (on page 30).

Error 410

The connection to the SD card is unstable.
(with SD cards)

Use an external card reader.

Certified time cannot be updated. Please check:

»  Proxy settings (on page 21), especially access data and
Password

» List of time server under Settings -> time server
for example: cmtime.codemeter.com,
cmtime.codemeter.de, cmtime.codemeter.fr,
cmtime.codemeter.us

Error message at updating the license: The update for this license has already been written to the

Error at updating the CmSticks dongle. The dongle is up-to-date.

X=XOOOKKXXE

This update can no longer be read in.
The content of the CmStick has a
newer version, error229.
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Windows operating system shows the
message:

Low Memory

Windows operating system no longer shows
symbol for the Recycle Bin.

The dongle is identified as local memory. In some cases, this can
lead to the operating system giving the message "Insufficient
memory".

This message can be ignored.

Alternatively, the dongle can also be configured as removable
media. For details on configuration, see the Configure dongle
as removable media or HID device (on page 29) section.

Attention: Configuration as removable media can - depending on
the computer configuration - also lead to a computer no longer
booting.

This may happen if the dongle is identified as a fixed local
network.

Alternatively, the dongle can also be configured as removable
media. For details on configuration, see the Configure dongle
as removable media or HID device (on page 29) section.

Attention: Configuration as removable media can - depending on
the computer configuration - also lead to a computer no longer
booting.

Configure dongle as HID, mass-storage device or removable media

The dongle is integrated into the system as an HID device by default. This configuration is
recommended. The dongle can also be configured as a local mass-storage device or removable media.
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CONFIGURATIONS

Configured as:

HID device

Local mass-storage
device

Removable media

Configure dongle as an HID device or mass-storage device

Description

The dongle:

» Is not displayed in the list of
available drives

» Is not allocated a drive
letter.

The dongle is displayed and
managed as a local drive.

For configuration, see the
Configure dongle as an HID
device or mass-storage device
(on page 30) section.

The dongle is displayed and
managed as removable media.

For details about configuration
see the Configure dongle as
removable media chapter.

Limitations

Only available for CodeMeter dongles
without memory.

Can lead to:

» The operating system reporting too
little memory for the dongle

» theicon for the Windows Recycle
Bin no longer being displayed

» the dongle not being found in virtual
machines

With configuration as removable
media:

» The booting of the computer can be
prevented for with computers that
can boot from a USB drive

» The dongle appears as a drive in the
task bar and can be removed
(ejected) at any time

CodeMeter supports, from version 5.0, the Human Interface Device (HID) device class of USB
standards. CodeMeter dongles can therefore log onto the system as an HID (human interface device)
instead of a mass storage device. Special USB host drivers do not need to be installed for configuration,
because the functionality is provided by the operating system. The dongle is thus not shown in the list of
available drives and is not allocated a drive letter. HID support is available for all CodeMeter dongles

without memory.

Requirements:

» CodeMeter container with the identification "2-xxxxxxx" or "3-xxxxxxx".

» CodeMeter firmware 2.02 or higher.

» CodeMeter Runtime 5.0 or higher. Should the version of CodeMeter that you have installed be
less, you can download the current CodeMeter Runtime from Wibu Systems (www.wibu.com
(http://www.wibu.com/support-downloads.html)).
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HID TO MASS STORAGE DEVICE

To switch the USB communication from human interface device (HID) to mass storage device:
1. Check, in CodeMeter WebAdmin, the status in the Content (CmContainer) tab.

2. Nodrive is assigned.

CodeMeter WebAdmin
[“Home  [SUUTTH " Server  Configuration

CmContainer Licenses User Data Backup/Restore

CmContainer:
Name:

CmContainer Type:
Firg]

Status:

System Time (PC):
System Time (CmContainer): 201

Certified Time (CmContainer): 2012-11

Free Memory: 4 % (367.696 Byte Defragment

3. Call up the CodeMeter command line interface emu: Start -> Program Files -> CodeMeter ->
Tools -> CodeMeter Command Prompt.

4. Enter the following commands in the command line interface that has been called up:
C:\Users\fs>cmu32 /s [box mask-serial number] --set-config-disk MsdCommunication
5. The current status is displayed in the following output from the command line interface:
cmu32 - CodeMeter Universal Support Tool.
Version 5.00 of 2013-Jan-30 (Build 1039) for Win32
Copyright (C) 2007-2013 by WIBU-SYSTEMS AG. All rights reserved.
- CmStick/C with Serial Number 2-2251132 and version 2.01
Version: 2.01
Flash Size: no real flash available
Virtual Drive: No drive assigned (HID)
Communication: Human Interface Device (HID)
Please replug your CmDongle to apply the changes.
6. Remove the dongle from the computer.

7. Reconnect the dongle to the computer.
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8. In the CodeMeter Control Center, the switch to MSD is shown in the Events tab.

© CodeMeter Control Center =
File Process View Help

Ucense | vents [ gorrow. |

ZOVEUT-3T TI29 22 FOURG NeW Sntres. ¥
2013-01-31 13:31:03: API Error 209 (NO DATAAVALABLE) occurred
2013-01-31 13:31:02: API Error 209 (NO DATAAVALABLE) occurred
2013-01-31 13:31:03: API Error 209 (NO DATAAVALABLE) occurred
2013-01-31 13:31:03: API Error 209 (NO DATAAVALABLE) occurred
2013-01-31 13:31:03: API Error 209 (NO DATA AVALABLE) occurred
2013-01-31 13:31:03: API Error 209 (NO DATAAVALABLE) occurred
2013-01-31 13:31:03: AP| Error 209 (NO DATAAVALABLE) occurred
2013-01-31 13:36:23: Access from localPV6) to ¥ (Handie 435)
2013-01-31 13:35:23: Handle 435 released
2013-01-31 13:36:23: Access from locakIPVE) to I (Handie 425)
2013-01-31 13:36:23: Handle 435 released
2013-01-31 13:37:44: Removable Device has been plugged OUT!
2013-01.31 13:37:44: The list of avaiable CmContainers has been updated
2013-01-31 13:37:44: The Ist of avalable CmContainers has been updated!
2013.01-31 13:37.:44. pess cacn B found 0}
D49-0T=IT13:37:51: Removable Device has been plugged N
943-01.31 13:37:51: Detecting CmContainer with Serial Number 2225113
2013-01-3113:37 T o SATANT! FEntly tound 1)

CodeMeter is started. | WebAdmn

9. Check the drive in CodeMeter WebAdmin, in the Content/CmContainer tab. A drive is entered
but there is no flash memory.

CodeMeter WebAdmin Cw

[“Home [ZTIPServer  Configuration  Diagnosts  Info
CmContainer Licenses User Data Backup/Restore

CmContainer: 2-22511%2 i~
Name: <no name>

CmContain

First Device:

DYoisatied
Enabled until Unplugged
B enabiag

System Time (PC): 2013-01-31 13:42:30
System Time (CmContainer): 2013-01-21 13:42:31

Certified Time (CmContainer): 2012-11-26 15:37:36 | update. |

Free Memory: 94 % (367.696 Bytes) | Defragment

MASS STORAGE DEVICE TO HID

To switch USB communication from mass storage device to human interface device:

1. Check, in CodeMeter WebAdmin, the status in the Content (CmContainer) tab.
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2.

A drive is assigned but there is no flash memory.

CodeMeter WebAdmin C\/J

CmContainer Liconses User Data Backup/Restoro

CmContainer:

Name:

CmContaine|

System Time (PC):

System Time (CmContainer): 201

Certified Time (CmContainer): 2012-11-26

Free Memory:

Call up the CodeMeter command line interface emu: Start -> Program Files -> CodeMeter ->
Tools -> CodeMeter Command Prompt.

Enter the following commands in the command line interface that has been called up:
cmu32 /s [Boxenmaske-Seriennummer] --set-config-disk HidCommunication

The current status is displayed in the following output from the command line interface:
cmu32 - CodeMeter Universal Support Tool.

Version 5.00 of 2013-Jan-30 (Build 1039) for Win32

Copyright (C) 2007-2013 by WIBU-SYSTEMS AG. All rights reserved.

- CmStick/C with Serial Number 2-2251132 and version 2.01

Version: 2.01

Flash Size: no real flash available

Virtual Drive: E:

Configuration: LocalDisk with ActivePartition

File System: FAT32

Communication: Mass Storage Device

Boot-Code: Int18 Boot Code

Mdfa: 0x539

Remove the dongle from the computer.

Reconnect the dongle to the computer.
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8. Inthe CodeMeter Control Center, the switch to HID is shown in the Events tab.

(S CodeMeter Control Center ==
File Process View Help

Liense | Events | Borrow

2013-01-31 13:29:19: Removabie Device has been pugged OUT!
2013-01-31 13:29:19: The st of avaiable CmContainers has been updated
2012-01-31 13:29:19: The iist of avalable CmContainers has been updated
2013-01-31 13:29:19. A CmContainer has been removed (currently found 0)
2013-01-31 13:29:21: Removabie Device has been plugged IN'

2013-01-31 13:29:21: The list of avaiable CmContainers has been updated
2013-01-31 13:28:21: The kst of avaiah sCantainers has beeq updated
28TTAT 1329 21 Deteciing CrContaines with Secal Number 2.225 1132 (1) >
2013-01-31 13.29.22. A new CaxonTaner s avatabwe [ F

2013.01-31 13:29:22° Found new entries: 1

CodeMeter s started. [ webadnn |

9. Check the drive in CodeMeter WebAdmin, in the Content/CmContainer tab. Nothing should be

entered.

CodeMeter WebAdmin Cvj

Home [#S0TT Server  Configuration  Diagnosis o Help
CmContainer LUcenses User Data Backup/Restore

CmContainer: 2-2261132 =]
Name: <no namo>

CmContainer Type:

Status: Dosa
Disab
4 until Unplugged
B enabied
System Time (PC): 2013-01-31 13:44:57

System Time (CmContainer): 2013-01-31 13:

Certified Time (CmContainer): 2012-11-26 update

Free Memory: 94 % Defragment

7.2.2  WibuKey

WibuKey can be used at a single workplace or in a network. The dongle must be active in a USB port or

parallel port on the local computer or as a server on a network computer.

To check the settings of the stick:

1. Install the WibuKey administration software from the installation medium.

Save location:
\AdditionalSoftware\WIBU-SYSTEMS WibuKey
Use this software for licensing with the network dongle.

2. Open the Control Panel.
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3. Open the WibuKey system control element.
4. Select the stick to be tested on the local computer or on the network.
To list server Wibu boxes in the network, click on the Read in button.

5. Check if the number in the last column of the second row is identical with the starting number of
the stick.

o

+ WIBU-KEY Software Protection: Test and Settings

Contents | Network | Irstall | About |
WIBL-BOX Tres:

2} My Compuiter
w8 Network

You can read more about the operation of the stick in the network dongle (on page 35) chapter.

Network dongle

To use a WibuKey in the network as a dongle, the server and client must be configured accordingly:
» Server configuration (on page 36)

» Client configuration (on page 36)

A Attention

WibuKey uses port 22347. This port is fixed and cannot be changed. Note:

» If afirewall other than that integrated into the Windows operating system is
used, this port must be enabled if you wish to use the WibuKey as a network
dongle.
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Configuring the server

The WibuKey server has to run on the dongle server. The WibuKey server can be configured either as an
application (e.g. started via Autostart) or as a service.

On installing the WibuKey software the options
32 Bit WkNet/WKLAN network server
Install as NT service with Autostart

have to be activated, so that the WibuKey server is installed as a service (recommended).

&) WiBUKEY Setup (o [ ]

Select the WIBU-KEY components you like to install:

v 132 bit WkNet AVKLAN Network Server

I Install as NT service with autostart
I wikNet Network Server for Novell Netware
vV WkLANAwkNet Network Monitor (32 bit)
[~ wkNel i
r

5 bit]

Once you have selected the components you wish to install,
press the sNexte button to complete the installation.

< Back I Next> I Cancel |

In order to start the WibuKey server as an application, a link to the file WkSvW32 . exe has to be
created in the Windows Autostart.

The file can be found in the C: /Programme /WIBUKEY/Server/ folder after installation.

Configuring a client

Some network settings for the client have to be entered in the Control Panel. Under WibuKey
subsystems, you can select the type of network access you use. The licensing of zenon uses the WkLan
subsystem.
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Under Server Name/IP address either the server name or its IP address or a mask for the IP address is
entered. With Browse the list is filled with all found dongle servers.

[ % WIBU-KEY Software Protection: Test and Settings [R5

Contents  Network l Install | About |
 WkNet Server Files —
Application WhkNet Server File

[ | Browse... I

[~ |User Specific v

~WIBU-KEY Subsystems —— ~ WkLAN Server Search List —

[Vl Local (Kemel) Server Name/IP address
(] WkLAN —I _J _I

O E18 Delete
~WkLAN Port Address Modnfy

]MkaLAN Blowse

oK I Cancel | Apply I Help I

The entries are processed in the sequence of the list and also can be combined.

If the first entry is a certain server, it is checked, if the dongle server service runs on that PCand if a

dongle is plugged in (faster!). If no dongle is found here and the next entry is a filter mask, all PCs in the
network going with that filter mask are are tried out.

On the Contents page, the server(s) where the dongles were found should then be listed:

r% WIBU-KEY Software Protection: Test and Settings 2

Contents I Network | Install | About |

WIBU-BOX Tree: USB, address : 1/1, version 4c
Iﬁ Desktop
=] d My Computer

F e

=@ cdsbg013
= USE
# 85561025

EditBox.. | [ = =] F

0K I Cancel I Apply I Help I

8. Command line parameter for licensing tool

The licensing tool can be controlled with the following flags as parameters:
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Passing over a parameter is done by putting a /" or a *-" before the parameter:

for example: /silent or -silent

Parameters

request

sernum:<num>

actkey:<key>

silent

mailto:<addr>

Description

forces the program to omit the first dialog and go straight to the dialog for
requesting the activation key
(it does not matter if the flag /silent or -silent is also used)

forces the program to use the serial number which is passed with <num> for
licensing instead of reading the number from the zenon6.ini file.

forces the program to use the activation key which is passed with <key> for
licensing instead of reading the key from the zenOné6.ini file.

forces the program to not show a dialog. The file License.txt is still created.

and forces the program to send
via e-mail.

works only in connection with the flag silent
the license request to the specified address <addr>

9. Remote licensing

To allocate a license to a computer via remote connection:

1. inthe context menu of the project select Remote Transport -> Change password and display

licensing

2. start the Remote Transport

3. assoon as the connection is established, the licensing of the remote computer is displayed

Remote License product

Serial number

Activation number

| Help |

Please enter the license information from your license
form/license sticker here.
Care for case sensitivity.

4. enter the serial number and the activation number of your license form

5. confirm the input by clicking OK

38



10. Characteristics of the Server Client operation

Licensing of modules in the server client operation has the following characteristics:

HISTORIAN

The following cases are distinguished:
» Server and client licensed: Archives can be opened and edited at the client
» Server licensed and client not licensed: Archives can be opened but not edited at the client

» Client not licensed and started as standalone: Archive window can be opened; the individual
archives cannot be opened

AUTOMATIC LINE COLORING

The following cases are distinguished:
» Server licensed and client not licensed: ALC functionality is available unrestrictedly

» Client not licensed and started as standalone: ALC functionality is not available

¥ Information

If the Server is licensed for the Energy Edition, ALC is also licensed.

BATCH CONTROL

The client gets the license from the server and does not need its own license. If the server does not have
a license of its own, the client cannot use the module.

LOAD MANAGEMENT

The following cases are distinguished:

» Server licensed and client not licensed: Load ManagementEMS functionality is available without
restriction

» Client not licensed and started as standalone: Load ManagementEMS functionality is not
available
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MESSAGE CONTROL

The client gets the license from the server and does not need its own license. If the server does not have
a license of its own, the client cannot use the module.

11. Everywhere Server by zenon

Everywhere Server gets the license of the Runtime. The license for Everywhere Server is issued by
Runtime. The Everywhere Server can not be used, If the Runtime does not have a corresponding
license.

For this reason, it may happen that the Runtime is running, but the Everywhere Server can not be
started because of missing license rights. In this case, please use the licensing tool (on page 4) in order
to receive a corresponding license.
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